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About this Manual

Descriptions

Windows NT is defined as the Microsoft® Windows NT® Workstation Operating system Version 4.0
and the Microsoft Windows NT Server Operating system Version 4.0.

Windows 95 and Windows 98, or Windows, is defined as the Microsoft Windows® 95 Operating
System and the Microsoft Windows 98 Operating System.

Windows 2000 is defined as the Microsoft Windows 2000 Professional Operating System and the
Microsoft Windows 2000 Server Operating System

Trademarks

LEADTOOLS is a program name of LEAD Technologies Inc.

LEADTOOLS is a registered trademark of LEAD Technologies Inc.

Microsoft® is a registered trademark of Microsoft Corp. in the U.S. and other countries.

Microsoft Internet Explorer is a product name of Microsoft Corp. in the U.S. and other countries.
Microsoft NetMeeting is a product name of Microsoft Corp. in the U.S. and other countries.
TCP/IP is a protocol standardized by the U. S. Department of Defense.

Windows is a registered trademark or trademark of Microsoft Corp. in the U.S. and other countries.
Windows NT is a registered trademark of Microsoft Corp. in the U. S. and other countries.

Products

LEADTOOLS®(Copyright© 1991-1997 by LEAD Technologies, Inc.) is included as a runtime
module.
smARTwriter for Windows 95/NT by Art Recognition Technologies, Inc
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1.1 Introduction

Congratulations on choosing Hitachi Software’s StarBoard Electronic Whiteboard—the whiteboard that’s
three meeting tools in one! You can use your StarBoard as a:

» Conventional Dry-Erase Whiteboard Without connecting the
StarBoard to a computer, you can use it as you would any other
dry-erase whiteboard, with any dry-erase markers and eraser.

»  Electronic Dry-Erase Whiteboard By connecting the StarBoard
to a computer and using the Dual-Mode Pen and Electronic Eraser,
all of your dry-erase notes can be saved and printed.

(See Electronic Dry-Erase Mode.)

Hitachi Software
StarBoard

» Electronic Digital Whiteboard By connecting the StarBoard
and an LCD projector (not included) to a computer, you can have
full access to all of your computer programs, plus Hitachi
Software’s special ShareWizard presentation applications.

(See Projection Mode.)

1.2 Parts Checklist

Standard Optional parts
StarBoard Electronic Whiteboard 0  Wall-Mount Brackets
Dual-Mode Pens Q Floor Stand (for Models 3040 and 4256)
Electronic Eraser Q Macintosh interface cable

PC interface cable

Power supply

Expo dry-erase markers
Projection Pens

Expo dry erase cleaner
Spare erasing pads

Spare marker caps

CD with software and driver

Iy I I I By Sy
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1.3 Mounting the StarBoard

There are two different ways you can mount your StarBoard:

» Hang the whiteboard on a wall using the wall-mount brackets
« Mount the whiteboard on the rolling floor stand

Installing Wall-Mount Brackets

1. Attach one of the two identical Wall-Mount Brackets to the back of the whiteboard using a

Phillips head screwdriver. Use (3) or (4) screws, depending on the size of your whiteboard (see
below).

2. Apply two self-adhesive Wall Bumpers to the back of the whiteboard. Locate the Bumpers in the
lower corners, one inch in from the edges as shown below.

o/'
/
|
P
R~ 7
Screw i
[M4-0.7 X 10mm Pan Hd. Mounting
w/ Internal Tooth Washer] Bracket
Wall Bumper (2)
3. Attach the second Wall-Mount Bracket to 4. Hang the whiteboard on the wall

a wall as shown below, using appropriate as shown below
hardware for the wall structure
(hardware not included).

Note: The hole spacing on the bracket -
accommodates wall stud spacings of 16 e
and 24 inches. 7
/
/
// \ { SfarBoard\
QY \
\ \ &\\”&\ \’\
Ngﬂg‘glﬁrc?ed \\
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Mounting StarBoard on a Floor Stand

4— 54.4" (38") —>

4¢— 62°(46) ——P

Measurement: Inches, () are for the DE3040

Floor Stand Parts List and Description &
6 &%
) @
©)
Item # Parts Name Qty. ©
(1) Legs 2 N
(2) Crossbar 2
(3) Foot 2
(€] Mountina Bracket (L) 1
(5) | Mounting Bracket (R) 1 (10) 1
(6) Flat Head Screw 4 6)
(7) Round Head Screws 8
(8) Washer 8
9) Sc.rews with Washer 6 4) (5) (7)T (11) [-
(10) Trianqular 4
(11 Wrench 1
(12) | wrench Holder 1 (8) (o) 12) D
(12) Please attach Wrench Holder on the Stand to
keep wrench for later use. 9) T
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Floor Stand Assembly

1. Attach mounting brackets to the back of the board using a Phillips head screwdriver.

(4)

BACK OF WHITEBOARD

Phillips
Screwdriver

0000000 0N

; N
\¢ 0coo0o0o0o0d
\ \

2
/ o
N/

© yo

(6 pcs)

2 With leg spikes facing outward, attach the two crossbars to the legs using the supplied allen
wrench, screws and washers.
3. Next, attach the feet with the longer portion facing forward.

Caution!
> The side of the leg Assembly with
& spikes faces away from the

&
/'\ Bl |« (€ Crossbars.

AV

g

(3)\ B \8:§,'~./
Caution! % (11) Tighten

Front end is (6

®
1 with
longer e ] Wrench




CHAPTER 1
Hardware Installation

4. Insert (2) triangular thumbscrews in each side of the stand. Do not tighten yet!

5. Hang the whiteboard on the stand by sliding the Mounting Brackets T-Slots
over the loose thumbscrews. Tighten thumbscrews when desired height is
determined.

1.4 Electronic Dry-Erase Mode

By connecting the StarBoard to a computer and using the Dual-Mode Pen and Electronic Eraser, dry-erase
notes can be saved and printed. (See Chapter 9 — Dry Erase Mode)

Hiacki Softuore
Elretronie. Widlsboard

Cosert tie eleclionic: whibhoand To & compeden

wid all youn day-oneas, cnlitions. com bo saved
{5 e ranpules end i o

1.5 Projection Mode

By connecting the StarBoard and an LCD projector (not included) to a computer, the StarBoard marker
pen provides full access to all of your computer programs, plus Hitachi Software’s special whiteboard
applications.

Hitachi Software
StarBoard
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1.5 Projection Mode (Continued

Procedure for working in Projection Mode:

1

2

Turn the projector’s power on

Position the projector so that the projected image is centered in the writing surface of the
whiteboard. Make the projected image as large as possible without extending it beyond the
white writing surface.

Run the Calibration program by selecting the StarBoard Driver from the ShareWizard Program
Group, or if already active, by double tapping the whiteboard icon at the bottom of the screen.
Select the Calibration button and the white screen with four corner marks will appear on your
computer screen. (See Chapter 3 — StarBoard Driver for more details.)

Using a capped Dual-Mode Pen or the new red Projection Pen, follow the on-screen
instructions to calibrate the whiteboard. When you touch the center of each corner mark, it will
change to a different color. When you touch the fourth corner mark, all four marks will
disappear. Click on OK.

You are now in Projection Mode. Use a capped Dual-Mode pen or red Projection Pen just as
you would a mouse to control your computer applications. (See Using the Dual-Mode Pen
for more information.)

Setup Tips

O

Your computer monitor’s resolution should be set to match the resolution of your projector
(some older projectors will not even project an image if the monitor’s resolution is not set
properly). Set the monitor’s resolution by selecting Settings/Control Panel/Display/Settings
from the Windows Start menu.

VGA Projector/Monitor 480 by 640 pixels
SVGA Projector/Monitor 600 by 800 pixels
XGA Projector/Monitor 768 by 1024 pixels

The projector’s input cable must be connected to the RGB jack (not the Video jack).
If the projected image looks compressed or you are unable to focus it properly, try turning the

computer monitor off (usually the Fn + a function key). Some older projectors will not project
an image if the monitor is turned on.
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Pen ldentification Number

The Dual-Mode Pen is so-named because you can use it
two different ways—remove the marker cap from the [
dry-erase marker to use the pen in Electronic Dry-Erase

Mode, or leave the marker cap on to use the pen in Projection Mode.

@END Hitachi Software

The Dual-Mode Pen is available in four different marking colors: black, red, green and blue. Each marker
holder is labeled with its default color and Pen Identification Number (black = 1, red = 2, green = 3 and blue
= 4). StarBoard includes two pens, but all four pens are available for purchase.

When writing with the Dual-Mode Pen in Electronic Dry-Erase Mode only, the color that the electronic data
is recorded in will match the color on the pen’s label. To change the color of the electronic “ink” to
something other than the pen’s default color.

(see Chapter 9 — ShareWizard Dry-Erase Screen)

Dual-Mode Pen Parts
The Dual-Mode Pen consists of the following parts:

* The Dry-Erase Marker puts ink on the whiteboard’s
writing surface. Use only Expo® or Expo2® dry-
erase markers with a “bullet” tip.
Dry-Erase Battery-Low  Electronic Eraser
« The Marker Holder is the tube that holds a dry- Marker Indicator _  (small-area)
erase marker. The tip of the dry-erase marker extends
out one end of the marker holder, allowing you to write ﬂ”]\
on the whiteboard. The marker holder contains a
transmitting coil in the tip end which, when writing with Marker Cap ~ Marker Holder Pen Base
the pen, sends a signal to the whiteboard conveying marker
tip position and color identification. The new red Projection Pens also fit in the marker
holder compartment

Hitachi Software

e The Pen Base contains electronic circuitry and the battery. Additionally, a transmitting coil for the
small-area electronic eraser is located at one end of the Pen Base. As you erase ink from the writing
surface, the associated electronic data is also erased. The erasing pad on the small-area eraser is
replaceable (see Maintenance/Installing new erasing pads). The pen base has a power-saving
feature that turns its circuitry off after five seconds of non-use. The red indicator light on the pen
base will blink when the battery has four hours or less of operating time remaining. (see Installing a
battery in the Dual-Mode Pen).

» The Marker Cap is used to keep the dry-erase marker from drying out. It is also used in
Projection Mode to prevent ink from being applied to the whiteboard.

» Supplied Red Projection Pens can be substituted for the Expo markers if only the projection mode
is going to be used. This is a dry felt tip marker, thus no marker cap is necessary. These projection
pens help prolong the board’s surface life.

*  Some Hitachi StarBoard pens have buttons located along the side that you can program. (See
Chapter 3 — StarBoard Driver for more information.)
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Installing a battery in the Dual-Mode Pen

The Dual-Mode Pen operates on one standard 1.5V (AAA)
battery. The red indicator light on the pen base will blink when

the battery has four hours or less of operating time remaining.

Hitachi Software E o I

1. Separate the Pen Base from the Marker Holder by grasping an

each part close to their joint. Carefully pull the pen halves
apart as shown

O

--|||

Remove the Battery Cover from the back of the Pen Base Marker Holder Pen Base
by inserting a small screwdriver (or tip of a ball-point pen)
into one of the openings shown. Pry the Battery Cover upward.

Insert a AAA battery, matching the “+” end of the battery
to the “+” in the battery compartment. Snap the Battery
Cover back into place.

Reconnect the pen halves by first aligning the tab on the Pen Battery Cover
Base with the notch in the Marker Holder. Push the pen halves
together until you feel a snap.

Installing a dry-erase marker in the Dual-Mode Pen

1.

Removing a dry-erase marker from the
Dual-Mode Pen

1.

Separate the Pen Base from the Marker Holder by grasping each part close to their joint. Carefully
pull the pen halves apart as shown in the figure above (top).

Remove the Expo®-supplied cap from a dry-erase marker of the appropriate color (color of
marker should match color of label on Marker Holder). Insert the marker in the Marker Holder.

Reconnect the pen halves by first aligning the tab on the Pen Base with the notch in the Marker
Holder. Push the pen halves together until you feel a snap.

Place a Hitachi-supplied gray Marker Cap on the tip of the dry-erase marker whenever the pen is
not in use, or to use the pen in Projection Mode.

Separate the Pen Base from the Marker Holder by grasping each part
close to their joint. Carefully pull the pen halves apart as shown in the
figure above (top). Remove marker from holder.

Dry-Erase
Marker

-10-
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The Large Electronic Eraser is for use in the Electronic Dry Erase Mode ONLY! When erasing ink
from the whiteboard’s writing surface, the associated electronic data is also erased. The erasing pad
on the Electronic Eraser is replaceable (see Maintenance and Installing new erasing pads).

Battery

. Cover
=

Installing a battery in the Electronic Eraser

The Electronic Eraser operates on one standard 1.5V (AAA) battery.
The red indicator light on the eraser will blink when the battery has four Battery-Low
hours or less of operating time remaining. Indicator

1 Remove the Battery Cover by first sliding it in the direction of the arrow on the label (see figure).
Turn the eraser upside-down—the Battery Cover will fall out.

2 Insert a AAA hattery, matching the “+” end of the battery to the “+” in the battery compartment.
Replace the Battery Cover and slide it closed until you feel a snap.

1.8 Maintenance

StarBoard was designed to be durable and virtually maintenance-free. Used with proper care and
handling, StarBoard should provide you with many years of reliable service.

Cleaning the StarBoard
1. Clean the writing surface of the StarBoard as needed with Expo® dry-erase cleaner. You can
replace the writing surface if it becomes uncleanable or damaged

2. Clean the Dual-Mode Pen, Electronic Eraser and other parts of the StarBoard with a mild liquid

cleaner. Do not spray the cleaner directly on these components. Instead, dampen a soft cloth with a
mixture of water and the cleaner.

Installing new erasing pads

1. Peel the old erasing pad away from the pen or eraser, making sure that the adhesive is removed as
well.

2. Remove the adhesive liner from a new erasing pad. Align the pad with the pen or eraser and press
firmly and evenly to secure it.

-11 -
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1.9 Technical Specifications

StarBoard Electronic Whiteboard

Technology: Cordless electromagnetic

Resolution: 1000 Ipi (lines per inch)

Tracking rate: 120 ips (inches per second)

Operating modes: Electronic dry-erase and Projection

Writing surface: Dry-erase marker- and video projection-compatible;
Replaceable

Active area: 42” x 56” (Model 4256)

30” x 40” (Model 3040)
Power requirement: 9VDC @ 500mA

Controls: Mechanical power on/off switch, four touch switches (Save, Save &
Clear Screen, Clear Screen and Print)

Indicators: Power (green LED illuminates when power is on)
Signal strength (green LED illuminates with varying intensity
to show strength of signal received from pen or eraser)

Colors: Panzer grey plastic extrusions and corner pieces; White writing
surface

Dimensions: Model Whiteboard Whiteboard & Stand
4256 61" x 47" x 3.5” 87" x 47" x 26"
3040 45" x 35" x 3.5” 71" x 35” x 26"

Weight: Model Whiteboard Whiteboard & Stand
4256 32 Ibs. 58 Ibs.
3040 18 Ibs. 42 Ibs.

Dual-Mode Pen

Technology: Cordless electromagnetic

Marker: Sanford Expo® and Expo2® with Bullet tip

Touch activation force: 1.5 oz. (pen tip and eraser)

Battery: 1.5V (AAA)

Battery life: Approximately 200 hours of continuous use

Indicator: Low-battery (red LED blinks when approximately 4 hours or less
of operating time remains)

Erasing pad: Felt; 0.63” diameter

Body: High-impact ABS plastic

Color: Panzer grey

Dimensions: 0.9” diameter x 7.4” length

Weight: 0.1 Ib. (including battery)

-12 -
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Large-Area Electronic Eraser

Technology: Cordless electromagnetic

Touch activation force: 1.5 oz.

Battery: 1.5V (AAA)

Battery life: Approximately 200 hours of continuous use

Indicator: Low-battery (red LED blinks when approximately 4 hours or less
of operating time remains)

Erasing pad: Felt; 2.8” diameter

Body: High-impact ABS plastic

Color: Panzer grey

Dimensions: 3.2” diameter x 1.3” high

Weight: 0.2 Ib. (including battery)

1.10 Technical Support

For technical support, please have your unit’s serial number available when you contact us.

To receive technical support or further information on Hitachi Software’s StarBoard,
please contact us toll free in the US at:

1-888-615-9600
ext.7614

Hitachi Software Engineering America, Ltd.
601 Gateway Boulevard, Suite 500
South San Francisco, CA 94080

Web: http://www.StarBoard3D .com
Email: support@StarBoard3D.com

-13-



Chapter 2

StarBoard Suite
Installation &
Getting Started with
Launcher

14



CHAPTER 2
Software Installation & Launcher

Table of Contents

Installation
2.1 INStalling StarBOard SUITE.......c.ccveveriiiieiiiise ettt reeneas 16
2.2 Providing Enduser INfOrMAation ............cooiieiieiiiisiecie st sne s 16
2.3 Choosing Program DeStINALION............cceiiiiieiieeiieie e se e e e et sre e esaesneseeseesneas 17
2.4 Customizing INStall OPLIONS .......cviiviiiiciese e e seens 17
25 SEAMT-UD OPLIONS ...ecviitiieieetee ettt bbbttt b et eb bbb b e ebenn e b nresea 18
2.6 Installing ACrobat REAUET 4.5........oiiiieieie e e 18
2.7 INSEAIlING SMARTWIITET ...ttt 18

ShareWizard Launcher
2.8 Running Launcher for the FirSt TIME .....ccvocciiiiiise s 19
2.9 I V0 g Tod o T Lo AN o] o] FTo=Uu o] 1 -SSR 19
2.10 The LAUNCHET IMIBINU ..ttt bbbt sttt sttt nne s 20
211 The ADOUL DIAl0G BOX .....c.viviiiiiiiiieciie s 20
2.12 CloSING the LAUNCRET .......eiiiie ettt et nee e 20

Customizing ShareWizard Launcher
2.13 The DefaUlt SEIINGS ....vcviieieiee sttt se et resresreeneereens 20
2.14 Changing DOCKING EAQES ........eveiiieieiiiieiietesie ettt 20
2.15 Floating Window and Button Arrangement StYIES ..........ccvoereiieneieneieeneee e 21
2.16 Large and SMAll WIBWS........couiiiiiiieieeee ettt st sttt e 21
2.17 SROW TOXE. .ttt ettt et b et bt et e bt b et e b et sa et nbeeteeneebe e 21
2.18  AIWAYS ON TP ettt ettt bbb bbbkt bbbt e 22
2.19 F AN (o o T [OOSR 22
220 AULO FE oot b et bbbt ene 22

15



CHAPTER 2
Software Installation & Launcher

2.1 Installation of StarBoard Suite

The installation routine will automatically perform setup when the StarBoard Suite installation disk is
inserted in the CD drive. The StarBoard Suite Logo will appear, during the initial scan for system
requirements.

StarBoard Suite

ShareWizard Installation program will prompt user to read and agree to the License Agreement.

2.2 Enduser Information

Please provide a valid User’s Name and Name of the Company. Without a Company name the “Next
Option” will not be available.
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2.3 Choosing Program Destination

Users will be prompted to save program files to a specific destination or the default location.
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Press “Next” to proceed with the default settings.

2.4 Customizing Install Options

Users can customize their installation profile by selecting specific programs to install. If certain programs
are not installed on the first installation, the option to add or remove programs is available in future
sessions.
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When finished with the customizing of the StarBoard Installation program, the actual installation process
will begin. A dialog box will monitor the installation progress.
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To cancel the installation procedure, simply press cancel and follow the instructions.
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2.5 Start-Up Options

When the installation procedure is complete, the install program will prompt users with the option to
include both StarBoard Driver and/or Launcher during the next “Windows bootup”.
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2.6 Installing Adobe Acrobat Reader 4.05

To access and read the electronic StarBoard User’s Manual, user’s may install Adobe Reader v4.05.
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To install Acrobat Reader, click the “Yes” button and follow the instructions provided on the screen.

2.7 Installing sSmARTwriter

The smARTwriter installation program will only appear if Handwriting Recognition was selected during
the Customize Installation procedure. A dialog box will prompt users to proceed with smARTwriter
Installation. (For operating instructions on Handwriting Recognition please refer to Chapter 5)
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2.8 Running Launcher for the First Time

When StarBoard Suite Launcher is opened for the first time, a Dialog box like the one shown below will
appear. It shows a list of StarBoard Suite applications that can be launched with the Launcher buttons.
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To have this dialog box displayed in the future, check the box above the OK button. If not selected, the
dialog box will only appear when the list of available StarBoard Suite applications changes (e.g. if an
application is installed or uninstalled).

The Launcher will be created in the default style, docked to the top edge on your screen as shown below:

el L] Mabsibiangad i o Hasieirs s +y T PN

2.9 Launching ShareWizard Applications

To launch a StarBoard Suite application, simply click on the program button in the Launcher. When the
cursor is positioned above a launching button, the name of the corresponding application will be displayed
as a tool tip.

E ShareWizarF'en ﬁ rultib ediakl otepad E\rfideo Pen
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2.10 The Launcher Menu

The Launcher menu can be displayed by right clicking anywhere on the Launcher bar. A right click can be
performed by tapping the StarBoard with the opposite end of the marker pen.
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Active menu items have checks to the left of their name.

The first five menu items above the separator customize the apprearance and behavior of Launcher. A
more detailed explanation of each option can be found in Sections 2.13 through 2.20 of this chapter.

2.11 The “About StarBoard Suite” Dialog Box

To view information about StarBoard Suite, select “About StarBoard Suite” from the menu. A dialog box
identical to the one shown when the Launcher is opened for the first timewill appear.

2.12 Closing the Launcher

To close Launcher, either:
e Select exit from the menu
e Click on the close button of Launcher if it is in floating mode (see Sections 2.12-2.15)

2.13 The Default Settings

By default, the Small View, Show Text, Always On Top, and Auto Fit options are checked, while the Auto
Hide option is unchecked. Each option is explained in detail in the following sections. Launcher is
initially docked to the top edge of the screen.

| Pen L HulMedabiotepsd 7 Vadeo Pas i D St Kol + ) Toksbbosien] MD’:.-EIM

2.14 Changing Docking Edges

Launcher can be docked to any of the four edges of your screen. To move Launcher from one edge to
another, simply click on a non-button area of Launcher, drag, and drop Launcher at the desired edge.
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2.15 Floating Window and Button Arrangement Styles

Launcher can also be displayed as a floating toolbar. To change the Launcher display, drag and drop
Launcher to anywhere within the work area of Windows.

When Launcher is in floating mode, the button arrangement (such as the number of rows) can be changed
by dragging the window frame and resizing Launcher.
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2.16 Large and Small Views

By choosing View Small or View Large from the menu, the view of the buttons can be changed. The
following is an example of each view mode:

Small View:

S

Large View:

My Compriter

2.17 Show Text

If “Show Text” is checked, the application name will appear by each button.

] Sharewizard Pen EJ MultitdediaMotepad 7 widen Pen

Small View with Text:
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Large View with Text: @ %:;q!:?
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2.18 Always On Top

When “Always on Top” is checked, Launcher will remain on top of other applications even when it is not
active or the focused window. Otherwise, Launcher acts like an ordinary window.

2.19 Auto Hide

When “Auto Hide” is enabled, Launcher moves off the screen when not in use. Only a thin edge will be
visible. To access Launcher, position the mouse over the thin edge, and Launcher will move into view.
When the mouse leaves the Launcher window area, Launcher will once again move off the edge of the
screen.

To hold Launcher in place when Auto Hide is enabled, click on the Launcher window to activate. To
release Launcher, simply select another window.

2.20 Auto Fit

When “Auto Fit” is checked, the size of the docked Launcher is automatically adjusted to take up the
minimum amount of window space. Launcher cannot be resized when docked in this mode.

When “Auto Fit” is unchecked, the docked Launcher is resizable by dragging the frame. However,
Launcher cannot have an area smaller than the total area of the buttons.
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3.1 Introduction

The StarBoard Driver is a software program that sets up the parameters for the interaction between the
StarBoard and a computer

StarBoard Driver Functions:

- Calibration of Board

- Configuration of Pens

- Com-Port Configuration

- Auto-Detection Sequence at StartUp

3.2 Running StarBoard Driver

The StarBoard Driver program is responsible for the setup and control of the whiteboard hardware with the
computer.

Activate the StarBoard Driver by
1. Selecting StarBoard Driver through the ShareWizard program group.
2. If already running, double click the whiteboard icon at the bottom of the screen.

When executing StarBoard Driver, the software will perform an auto-detection routine to determine the size
and model of the StarBoard and which communication port is being utilized. Upon detection, the software
will test the connections by sending a series of electronic signals to the StarBoard. A set of four beeps
indicates that the StarBoard has successfully established connection with the computer.
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A Driver dialog box will appear after the preliminary tests. The StarBoard connection information will be
shown on the left hand side of the dialog box. When the StarBoard is connected properly, there should only
be one type of StarBoard shown inside the style section.
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3.3 Calibration System

To synchronize the screen’s active area with the projected computer image it is necessary to calibrate the
electronic whiteboard system. After centering the projected image within the white screen surface (See
Section 1.5 — Hardware Installation/Projection Mode), click on the calibration button. Once the calibration
system is activated, follow the instructions in the center of the screen carefully. In the event that was an
accidental double hit or the wrong cross mark selected, the calibration procedure should be aborted and
then re-launched using a mouse. After a successful calibration, click OK and the pen can then be used as a
mouse or drawing instrument.

NOTE: Anytime the screen or the projector has been moved, a new calibration will need to be
performed! When StarBoard is attached to a floor stand it is highly recommended that the
wheels are locked down to prevent movement after the projected image is centered.

[© ]

[ |

3.4 Pen Button Configuration
NOTE: The Button Configuration is only available for the R70 Rear Projection units.

Please select desired corresponding action to the pen button
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3.5 Double Click Configuration

To change the electronic pen tapping speed, tap once on the Double-click Configuration icon. A dialog box
will appear with the option of changing the Double-click distance and tapping speed.

[ | T-. - Te dyes
El
Fa Fhow
Coublecickfpasd 3
[ ] _ Cwent | e |

3.6 Battery Test

The power output of the electronic pen is determined by selecting “Check Pen Condition.” An average
AAA battery will last up to 200 hours when used properly. A change of battery is recommended if the
Electronic signal is below Level 6. With a fully charged battery, the Pen Condition meter signal will
advance to “9” when the pen is touching the board and decrease as the pen is removed. This procedure is
active for 30 seconds.
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3.7 Stop Driver

Stopping the driver will terminate the connection between the StarBoard and the computer. The Electronic
Pen will not function.
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4.1 Introduction

ShareWizard Pen is a robust annotation program that allows users to:

1. Draw or Highlight over computer applications and captured images
2. Save annotated images in a variety of formats
3. Print annotated images

4.2 The Windows of ShareWizard Pen

ShareWizard Pen is composed of a main window and a page window. The following graphic indicates the

ShareWizard Pen windows:
Main Window
The main window allows the

user to select an operation or a
tool in ShareWizard Pen

 ————— Page Window

This area is used for making
annotations with the currently
selected tool.

4.3 The Main Window

A detailed picture of the main window is shown below:

—
£ 22D =] X \ oo  cotion monce,
blzlal ol==] &

Buttons
Each button represents a
ShareWizard Pen operation

or tool.
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4.4 The Buttons of ShareWizard Pen

The following chart explains the function of each button in ShareWizard Pen. If a button is grayed out,
then it is temporarily not a valid selection.

Button Name Description

rd Pen Makes annotations with the pen tool

yad Highlighter Makes annotations with the highlighter tool

&) Eraser Erases desired annotations

B Mouse Closes the screen capture window and returns
to normal mouse operation

8| Palette Selects the color of the pen / highlighter

= Thickness Selects the thickness of the pen / highlighter /
eraser

| Delete All Erases all annotations on the current page

ﬂ New Page Creates a new page

2 Open Opens a file

&l Capture Captures the screen display

& Previous Moves to the previous page if one exists

k=i Browser Opens the page browser

=Y Next Moves to the next page if one exists

=] Print Prints out the current page

4.5 Making Annotations with the Pen Tool

Click on the 2 button in the main window to turn the mouse pointer into the Pen tool. The pen is now
active for making annotations over any application or screen image. The current color of the Pen Tool will
be displayed on a horizontal line through the icon

4.6 Making Annotations with the Highlighter Tool

Click on the #| button in the main window to turn the mouse pointer into the Highlighter tool. This
marking tool is now active for highlighting
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4.7 Erasing Annotations

Click on the £l button in the main window to turn the Pen or Highlighter tool into the Eraser tool. Select
the Eraser button and drag on the page window to delete any annotations underneath the eraser cursor.

4.8 Changing Colors

To change colors for the pen or highlighter tool, click on the 5 button in the main window and choose a
color from the pull-down color palette.

4.9 Changing Tool Thickness

To change the line thickness for the pen, highlighter or eraser tool, click on the =l vutton in the main
window and choose a line thickness from the pull-down menu

4.10 Deleting All Annotations on the Current Page

Click on the ] button in the main window to delete all annotations on the current page. A dialog box to
confirm the operation will appear. To delete annotations, click [OK] or click [No] to cancel and preserve
the current page’s annotations.

4.11 Adding a New Page

Click on the ] button in the main window to add a new blank page.

4.12 Saving Pages
Captured screen images with annotations can be saved as image files.

To save the contents:

Click on in the title bar. The system menu appears.

Select “Save” from the system menu. A “Save As” dialog box appears
Select the location and change the file name if needed.

Select the file format.

Select either “Save All Pages” or “Save Current Page”.

Click on [Save].

ocoupwdE

ShareWizard Pen supports “JPEG”, “BMP”, “PNG”, and the proprietary “ShareWizard Pen” file formats.
The “ShareWizard Pen” file format has a “.swm” extension. The “ShareWizard Pen” file format contains
the following additional features:

O Stores multiple pages in a single file

O Minimizes disk space usage

0 Keeps annotations in a separate layer so that annotations can be edited (including erasure)
in future sessions.
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4.13 Printin

Print the current page by clicking on Bl in the main window to display the “Print Properties” dialog
box. Click [OK] once the properties are set.

4.14 Capturing Screen Images

Screen images can be captured so that annotations can be added interactively. Capturing is a simple
process that can be used at any time with minimal interruption, making it ideal for live presentations.

To capture a desktop image:
1. Click on Bl in the main window to go into mouse operation mode.

2. Open any document with the appropriate application.
3. Click on : ﬂ 4 or ﬂ and ShareWizard Pen will capture the entire desktop image.

4.15 Opening a File

Previous sessions’ image files (*.bmp, *.jpg *.png or *.swm) or Dry-Erase Screen files (*.wnr), can be
opened for display in the page window.

To open a file:

1. Click on 2l in the main window to open the “Open” dialog box.
2. After, selecting a file, click on the [Open] button.
3. The selected file is opened and becomes available for annotating.

4.16 Image Browser
It is often convenient to switch between different pages during a presentation

To move to a different page:

1. Click on 2 in the main window to open the “Browse” dialog box.
2. Select one of pages and click on the [Select] button.

The “Browse” dialog box contains a list of valid pages for the current session. If a desireirage is not in
the list, it can be added either by clicking on Blifitisa prepared page or by clicking on Bl if it is a new
image capture.

To move forward and backward through the page list, click either o B
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4.17 Deleting Captured Pages

To delete a page:

1. Click on Bl in the main window to open the “Browse” dialog box.
2. Select one of pages and click on the [Delete] button.

Only the current page cannot be deleted. To delete the current page, first move to an alternate page and
then repeat the above steps.

4.18Changing the Page Order

To change the page order

1. Click on B in the main window to open the “Browse” dialog box.
2. Drag & drop the target page to change the page order.

4.19 Designating the Default “Save File” Location
The default location of the folder in the “Save As” dialog can be designated.

To configure the save location

Click on in the title bar to access the system menu.

Select “Option” in the menu. The “Option” dialog box then appears

Click on the “Save” tab if it is not already the active tab

Type in the default location in the “Folder Name” box or click on the [Browse] button to
search for a folder.

5. Click on [OK] to confirm the change.

PR

4.20 Configuring the Cursor Display Status

The Cursor Display Status can be configured.

Show : The cursor is always shown.
Hide . The cursor is hidden when the pen is away from the StarBoard.
None : The cursor is always hidden.

To change the status of the cursor:

Click on in the title bar to access the system menu.

Select “Option” in the system menu. The “Option” dialog box then appears
Click on the “Cursor” tab to show the cursor options

Choose the cursor display status.

Click on [OK] to confirm the change.

A
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4.21 Configuring the Button Size

There are two sizes available for the main window buttons:

Standard Size Small Size

A= B Z ¢l@ol =] |
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To configure the button size:

Click on in the title bar to access the system menu.

Select “Option” in the system menu. The “Option” dialog box then appears
Click on the “Button” tab to show button options

Set the size of the buttons.

Click on [OK] to confirm the change.

4.22 Configuring the Display Style

The display can be set to one of the following styles:

agrwbdE

Page number : The page humber is displayed on the upper right corner.
Time : The current time is displayed on the upper right corner.
None : Nothing is displayed on the upper right corner.

The display frame can also be toggled on or off.

To configure the display style:

Click on in the title bar to access the system menu.

Select “Option” in the system menu. The “Option” dialog box then appears
Click on the “Style” tab to show the display style options.

Set the display style.

Click on [OK] to confirm the changes.

4.23 Configuring Confirmations

The settings of the “Delete All” dialog box can be configured. The display of the “Delete All”
confirmation dialog can also be toggled on or off.

agbrwbdE

To configure the confirmations:

Click on in the title bar to access the system menu.

Select “Option” in the system menu. The “Option” dialog box then appears.
Click on the “Confirmation” tab to show the confirmation options.

Set the confirmation settings.

Click on [OK] to confirm the changes.

agrwbhE
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Tips & Notes

The Display Color Palette

While ShareWizard Pen is running, do not change the color palette of the display from over 256 colors to
less than 256 colors without restarting the computer. This may affect the color of annotations. We
recommend a display with High-Color (16-bit) or more.

Capturing the screen

Please wait for an application to finish drawing before attempting a screen capture. Otherwise, the captured
image may be incomplete.

Microsoft NetMeeting

When ShareWizard Pen is running, Collaborating using Microsoft NetMeeting’s application sharing may
not work properly. To use MS NetMeeting’s collaboration feature, first exit or minimize ShareWizard
Pen.

Printing
Print functions may not work with certain printers. In such cases, set the Spool Settings to "Print Directly
to the printer" and try printing again.

Multiple Monitors

ShareWizard Pen does not support multiple monitors. Annotations can only be made within the primary
monitor.

IME 98 Toolbar

IME 98 may not be hidden underneath the ShareWizard Pen window.

Opening an Image File

Opening an image file with a size that differs from the display screen size may result in a poor image
conversion.

Quality of Image Files

The quality of an image file decreases when saved in JPEG format. For maximum quality, use BITMAP
or PNG.

Maximum Number of Pages

The maximum number of pages depends on memory size and free disk space. Make sure that disk space
is available when creating pages.

CHM Format Help File

If Internet Explorer version 4.0 or later is not installed (e.g., Windows 95), there is no way to view CHM
format help files. In this case, view the HTML format help files instead. Open (installed folder)
Help\index.htm with your web browser.

Exiting ShareWizard Pen
Some dialogs may remain opened after exiting. In this case, simply close the dialog to exit.
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5.1 Introduction

The Handwriting Recognition program allows users to input text directly into most software applications
simply by printing in their own handwriting on the StarBoard .

5.2 Activating and Deactivating Handwriting Recognition

To activate the Handwriting Recognition program:

1. Select Handwriting Recognition from the ShareWizard Launcher or go to
START>Programs>smARTwriter for Windows >smARTwriter.

2. When activated, this program produces a pen/pointer icon that toggles between the 2 functions
in the status bar at the bottom of the screen

|- 11:208M
Pointing Mode: o In this mode, the pen is used as a pointing/selecting device.
Writing Mode: f In this mode, the pen is used for handwriting recognition.

To deactivate the Handwriting Recognition program:

1. Double click on the pen/pointer icon in the status bar. A menu will appear. Select sSmARTwriter
and press the TERMINATE button.

5.3 Using the Program

To use the active Handwriting Recognition program:

1. Select desired application that you would like to insert text into.

2. Switch to the handwriting mode by clicking on the pen/pointer icon in the task bar. The icon
should be in the pen mode. In the active window, set the cursor to where the converted text
should appear.

3. Use the Pen to print anywhere on the active window. Input will appear as printing until writing
stops. The program converts the printing to text and places it at the cursor location.

5.4 Input Devices

Handwriting Recognition works with most input devices, including graphic tablets or even the mouse
itself. However, best results will be achieved when using the large format StarBoard.
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5.5 Limitations
Currently, Handwriting Recognition can only recognize printed (not connected or cursive) writing. It does

not support delayed strokes (that is, the “i” should be dotted and the “t” crossed immediately after writing
them).

5.6 How Does it Work?

When writing with the input device, "electronic ink" is created. Handwriting Recognition examines this
electronic ink, and when a Timeout occurs (the lifting of the pen for a certain time interval), Handwriting
Recognition passes the recognized characters to the active application.

Comparing YOUR written symbols against a set of defined Handwriting Recognition’s symbols performs
the recognition process. This set of symbols is called the Library. The Library contains many shapes of
letters, digits, punctuation marks, etc.

In the Library, symbols may be written in different ways. For example, the letter ‘G’ may be written in
various styles:

~

During installation, Handwriting Recognition creates a generic library containing common handwriting
styled characters. Therefore, it is likely that handwriting will be easily recognized even the first time
Handwriting Recognition is used.

5.7 Training Handwriting Recognition

Training is essential to fine-tune Handwriting Recognition. Fine-tuning yields a higher recognition rate
because Handwriting Recognition memorizes your own handwriting style. Handwriting Recognition can
be trained using any of the following methods:

1. Quick Trainer, an automatic tool for adding new letter models to the Library.
2. On-the-fly training, for training Handwriting Recognition by correcting a recognition error
whenever one occurs.

5.8 Achieving Good Recognition

1. Write continuously. There is no need to wait for Handwriting Recognition to recognize segments
of the written text.

2. Write using printed (not connected) handwriting.

3. Do not use delayed strokes. That is, dot the “i” and cross “t” immediately.

4. Avoid writing small characters. It may lead to a loss of resolution and result in misread
characters.

After using Handwriting Recognition for a few days, editing the Library and deleting redundant or
incorrect models is recommended.
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5.9 Modes of Handwriting Recognition

Pen operations and handwriting recognition are controlled and customized via the Handwriting
Recognition tray icon (bottom right corner of the screen). The icon indicates the following modes:

Pointing Mode: % In this mode, the pen is used as a pointing/selecting device.

Writing Mode: In this mode, the pen is used as a writing device.

J P 1138 M

Tapping once on the icon toggles between the modes.
Double-tapping the icon opens the Handwriting Recognition menu.

5.10 Writing Text

To write text:

1. Switch to Pointing Mode S and runan application (Word, Excel, PowerPoint etc.).

2. Switch to Writing Mode 4 . Make sure the insertion cursor appears in the document area. Write
to the screen. Handwriting Recognition reads this ‘ink,' recognizes it, and converts it into printed
text.

3. Using the pen, write a few words in the document area. Write continuously (one letter after the
other). It is not necessary to pause after each letter. The recognized text appears at the insertion
point.

5.11 Selecting Text

To select text while in an application such as Microsoft Word:

1. Switch to Pointing Mode .
2. Drag the pen over the desired text. The selected text will be highlighted.
Or
1. Switch to Writing Mode 4
Hold down the pen next to the desired text (for about half a second) until the program beeps.
3. Drag the pen over the text.

N

To select a single word (in any mode), just double-tap on the word.

41



CHAPTER 5
Handwriting Recognition

5.12 Using Gestures

A “gesture” is a symbol that activates a special function or enters a special character (e.g. backspace, new
line, etc.). The gesturesin Handwriting Recognition for Windows are:

Backspac  Space New
e Line
Edit Edit

Tab
Note: The heavy dot indicates the starting point.

For example, to use the Backspace gesture:
1. Switch to Writing Mode.
2. Write the Backspace gesture on the screen.
3. The character to the left of the cursor position is deleted.

5.13 Using the Edit Gesture and the Correction Vector

The correction vector is a tool that can correct misread text. Use it to correct the last written erroneous text.
The following example illustrates the use of the Correction Vector to train the Handwriting Recognition.

1.  While in an application, write words until a recognition error occurs.
2. Select the erroneous word.

3. With the pen, write the Edit gesture on the screen (see table on previous page). The Correction
\ector screen appears:

Frainer buttan 1 Correction

Help bution
Defete button Train check box
Original ink
Word fragile fruyil
suhstifzrtion frag! |e erJ'_',-'! |e
suggesiions _,_r[gyl & frudl .e
frogile bravile

4. The Correction Vector screen displays a list of suggested substitutions at the bottom of the screen.
The substitution suggestion order is determined by the probability of recognition (i.e., the first
word on the list is the most probable recognition).
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5. Choose the correct substitution from this list.
Note: If the Train box is checked before selecting the correct substitution, the written characters
will be added to the character Library.

6. The Correction Vector closes, and the original word will be replaced by the new word.

If the correct word does not appear in the list:

Tap the Dell hutton to delete the highlighted text, and rewrite the word.

Or

Tap the |22 | button to bring up the Trainer window. The text trained in the Trainer will replace the
original word in the document.

To leave the selection unchanged, tap anywhere outside the Correction Vector.

5.14 Starting with Dots

Since tapping once on the screen repositions the insertion cursor, it is impossible to start writing with a
dot. To place a dot at the beginning of a sentence, use one of the following signs:

Period Comma Colon Semicolon
Vv o~ 93 .7

Note: It is possible to train and use other signs instead of the ones shown above. When training new
signs, make sure the new signs that can be distinguished from existing ones.

5.15 Terminating Handwriting Recognition

To terminate Handwriting Recognition:

1. Double-tap the Handwriting Recognition icon in the icon tray (lower right corner of the screen).
2. From the Handwriting Recognition menu, select Handwriting Recognition.
3. Tap the Terminate button.

Note: Some applications cannot operate without Handwriting Recognition (all pen-aware applications).
Terminating Handwriting Recognition causes these applications to shut down.

5.16 smARTwriter

Selecting this option when double-tapping the Pen/Pointer icon will display the About HS Handwriting
Recognition dialog box with the version of the installed Handwriting Recognition and copyright
information. This dialog box also contains the Terminate button.
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5.17 Trainer

Select this tool to “teach” Handwriting Recognition your unique handwriting style. By training
Handwriting Recognition, handwriting recognition improves. When the Trainer opens, it displays the last
text written to the screen (i.e., the last written “ink™). Handwriting Recognition can then be taught how to
interpret that “ink." For more information concerning the trainer, please refer to the “Training Text”
section.

5.18 Properties

This menu option allows customization of Handwriting Recognition. For more information concerning the
trainer, please refer to the “Customizing Handwriting Recognition” section.

5.19 Help

The help button displays in-program help for Handwriting Recognition.
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5.20 Training Text

If a recognition error occurs, train the Handwriting Recognition so that it can recognize that letter or
sentence the next time the program encounters it.

To train text:

1. Choose Trainer from the Handwriting Recognition menu. The Trainer window displays the last
“ink” captured in the upper portion of the window and the misread text below.

3 Trainer
{ﬁ@V%% "
ENEeryy Tty
A 2
, & Text
Train As:
= Gesture
I Y T T O N N TN N R
 Inter.

2. Select the misread letter by tapping on either the “ink” or misread letter. To select several
successive letters, simply drag the pen across the desired letters.

3. Alist of possible characters for each selected symbol will appear on the bottom left of the Trainer
screen. Tap on the correct character or letter to select it. It will automatically appear in the
appropriate slot in the “Train As” area of the screen.

1 Trainer [<]
QﬁQV%% ”
ene ry Train
A El

. & Text
Train As:
g  Gesture
L g 1 1 1 1 ]
 Inter.

4. If the correct letter does not appear, write the correct replacement in the Train As area. Once the
correct replacement is written, either selected from the list of possible characters or through
handwritten input, in the Train As area, tap the Train button.

5. Close the Trainer window.

Note: Do not select more than one character at a time for training.
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Handwriting Recognition allows for the use of abbreviations while writing. These abbreviations are known

as shortcuts in the Handwriting Recognition environment. The Trainer allows the creation of symbols for
such shortcuts.

To create a shortcut:

1.  Write a symbol to be used as the shortcut and then open the Trainer.
2. Select the symbol from the top portion of the Trainer screen.

 Trainer <]

o
J_l j Train |

. = Text
Train As:
 Gesture
g, o0,0,db y e
 Inter.

3. Write the corresponding text in the “Train As” area and tap Train. Now, every time that symbol
is written on the screen, Handwriting Recognition will replace it with the corresponding text in
the document.

4. To close the Trainer window, either tap the %l button in the upper right-hand corner of the
window or tap anywhere outside the Trainer window.

5.22 Training Gestures

The Trainer can add custom gesture marks in the library. In addition, it can train a gesture to perform basic

editing commands. The following example explains how to include a custom gesture for the Undo
command in the library.

Write the symbol to be used as the Undo command gesture, and open the Trainer.
Tap the Gesture button to select it.

Select the symbol from the top of the Trainer screen.

Tap on the down arrow next to the Train As Gesture to display the pull down menu and select
Undo.

oD

+Trainer [<]

P
j_l d Train |

© Text

Train As Gesture:

j & Gesture
Tab =
Edit  Inter.
—  Cut{Cul+X)
Copy (Crl+C)
Paste (Ctrl+V)
Undo (Ctrl+Z)
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Tap the Train button. From now on, every time the symbol is written, Handwriting Recognition
will interpret it as the BackSpace command.

Note: If there is an existing gesture for the command in the library and a new gesture is trained
for the same command, either gesture can be used to perform the command.

To close the Trainer window, either tap the [¥l button in the upper right-hand corner of the
window or tap anywhere outside the Trainer window.

Note: Only one ink stroke can be trained as a gesture at a time.

5.23 Training International and Special Characters

The Trainer can include symbols to be used for special characters such as international and extended
characters in the library.
To include a custom symbol for an international character:

el NS

Write the symbol to be used as the international character and then open the Trainer.
Tap the Inter. radio button to select it.

Select the symbol from the top of the Trainer screen.

Select the appropriate character from the lower portion of the window.

+ Trainer
VO;Q- Q, Help
0 goe! Train
dla|ale|c|e|e||é|i[ © Text
f|T|i|6|fA|d|6|B|d
n © Gesture
+|g |0 ja|afi|y|b|¥ .
& |nter.

Tap the Train button. From now on, every time the symbol is written, the Handwriting
Recognition will interpret it as the international character.

To close the Trainer window either tap the % button in the upper right-hand corner of the window
or anywhere outside the Trainer window.
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5.24 General Properties

This tab allows customization of the behavior of Handwriting Recognition.

Timeout:

Correction
vector size:

Linguistics:

Space after

recognition:

H-"'l-"llllnl. Hist B | Lbasy | Coatrminds |

Lrmms - |
Lawchor et [B =
B g m:

P i s el

Controls the time Handwriting Recognition waits before it attempts recognition of the
“ink”, starting from the moment the pen lifts off the screen.

Sets the number of suggested words to display in the Correction Vector
window.

Enables or disables the Handwriting Recognition modular linguistic layer.

The modular linguistic layer allows Handwriting Recognition to recognize rules and
guidelines within a language. For example, if the “g” in “reading” is written very similar
to a “y," the linguistic layer (if enabled) detects that “iny” is not a typical ending in
English, and that “ing” is a more probably the correct ending. As a result, Handwriting
Recognition outputs “reading” as the recognized word.

The linguistic layer is active by default after installation of Handwriting Recognition.
However, it is useful to disable the linguistics layer for writing a sequence of characters
that is not plain English text.

Adds a space after each recognition (i.e., after each Timeout) when enabled.

5.25 Ink Properties

This tab allows customization of the way the electronic ink appears on the screen.

[ Imnq-lmhlhnhﬁl

wd b

—F4 -IE

K | Cees | v |

Ink Width: Changes the width of the electronic ink displayed when the up or down arrows are clicked.
The larger the number in this field, the thicker the ink appears on the screen.
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Ink Color: Displays a sample and changes the color selected for the ink.
To change the color, click on the Change button to display the Color dialog box.

o

olor [21=]

asic calors:

HEENTY

{2l
e EE
[FrmEE.
5 ..
S E

HEEEE -

Custom colars:
N T O
N

Define Custom Colors >> |

oK Cancel

The Color dialog box is a Windows standard color setting palette. It allows the selection of a new color
for the electronic ink (the color the handwriting appears on the screen).

5.26 Hot Key

This tab allows the selection of a hot key or shortcut to toggle between Writing Mode and Pointing Mode.

Ommal| v Moy | sy | Cormsusty |

Lk ShE ™ Pighi Sk
™ LakCu ™ Fight [

4 CECT

| teww | | Hw |
Select one of the predefined hot keys, or select “Other” to establish another preferred shortcut. When one
of the Ctrl or Shift keys is assigned, the toggling occurs after pressing and releasing the selected key.
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5.27 Library Properties

The set of characters and shapes recognized by Handwriting Recognition is called the Library of Models.
After installation, a pre-defined Library with over 450 distinct characters is set.The Library tab contains
the list of supported character shapes and symbols. If necessary, some redundant or unnecessary models
can be deleted to improve recognition. In addition, if there are multiple users on the computer, it is a good
idea to create more than one Library of Models (one for each user). By doing so, each individual can have
a Library, and Handwriting Recognition will be able to recognize each individual's personal handwriting.

et [ i Fanqumlomn

Geronad | ink | oty LlII'r|I!n-n-1|||
Towwrvmy Quah (57 Madek)
Mk | Loy
i 3 Sre
A A
il
‘-_.rll' !:I'."l
L I a|
W - BRadsl | ﬂ
[ | Come | | e |

Library name: Displays the Library name and the total number of models in the Library, in the upper
portion of the Library tab
Usually, the Library name is the user name.

Characters

List box: Displays on the left side of the Library tap all of the characters, shortcuts, and gestures
that exist in the current Library
To select a character, simply tap it.

Models box: Displays the models for the selected character.
The last model entered (trained) is the leftmost. Tap a model to select it.

Del button: Deletes the selected model when tapped.

Library Box:  Allows the saving of changes made to an existing library, the creation of a new library,
and the clearing of any changes made to a library since the last save.

Clear button:  Clears the Library by erasing all character shapes added with the training tools. All
changes made in the Library since the last save will be lost. A confirmation dialog box
will display.If “Load the Standard Library” is checked (recommended), before tapping
[OK], the standard model library will be loaded after clearing the existing one. If
“Create an Empty Library” is checked, an empty library with no models will be loaded.
Handwriting Recognition must then be trained before use.

Editing a

Library: Select the Library tab, and then make the necessary changes to the existing models with
the control buttons described above.
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Select the Library tab and then choose Change. A “Load Library File” dialog box
appears. Write the new Library name in the File name box, and tap [OK]. A
confirmation dialog box appears. To create a new library, tap [OK].

If a different Library is open, a prompt will ask if the old Library should be saved before
the creation of a new one.

A new Library is now available, and a dialog box suggesting that you complete a
training session appears. It is strongly recommended that you complete the training
session before proceeding. Tap [OK] to continue.

To change the Library to a previously created one:
1. Select the Library tab and then choose Change. The Load Library File box appears,

listing the libraries available. (library files have extension .LBR).
2. Choose a library from the list or write the library's name and tap [OK].

A library should be saved any time changes are made to it.
After making the necessary changes to a Library, click on the Save button.

5.28 Constraints

This tab allows the enabling or disabling of recognition constraint settings. Using this symbol filtering
tool is another method for improving recognition. As explained earlier in this document, the Library
contains hundreds of symbols that Handwriting Recognition searches through to match every character

that is written.

The Constraints filtering tool reduces the character search range, resulting in fewer

misread characters.

The following is an example for setting Constraints options:

1. Select the Constraints tab.

[ e Towides Proposties B
Gorweal| b, | Hok Fnp | Libsany Comrivanis |
F7 |Lovem Lanl
R g Lo
F g
7 Precwsm
F ten

[on ]  comou | |  ne |

2. Inthis window, all characters supported by Handwriting Recognition are divided into five sets. If
a set’s check box is marked, Handwriting Recognition then searches through this set each time it
attempts a recognition.

3. Uncheck all sets except the Lower Case and then tap [OK]. Now anything written is considered a
lower case letter.

4. Configure the Constraints settings. The best settings depend on the content and structure of the
writing session. Once completed, tap [OK].
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5.29 Using Quick Trainer

Quick Trainer allows the recognition software to learn YOUR style of writing, thus producing higher
recognition results. It takes less than ten minutes to complete one Quick Trainer session.

To run Quick Trainer:
1. Access the Quick Trainer program by going to:
START>Programs>smARTwriter for Windows>Quick Trainer

2. This launches the trainer program.

. ART Quick Trainer M R
# Clear |\/5ccem| ? Help |

i A
R = _Y.u C..,gé‘
i Bz mp i B
b OrGron Al (X
[ | - B
Jﬂu‘m.u@‘ﬁ. oy B o

0% Complete

1. Copy the characters in the slots or boxes to the space below, with one character in each slot.
Print in your normal style and pace.

2. The letters that are immediately recognized will be highlighted. If the program does not
recognize a letter, do not go back and try to correct at this time. You will be given more
sentences with the unrecognized letter later on. The percentage bar at the bottom of the window
indicates the progress of the session.

3. After writing all the words on the page, recognized or not, tap the Accept button. This will start
the next page of the trainer. To clear the entire screen, tap the Clear button.

Note: The Quick Trainer session can be repeated as often as needed. Repeating sessions may
improve recognition results.

5.30 Creating a Personal Library

After successfully completing Quick Trainer, the user will be prompted to save this Handwriting
Recognition library. Answering “yes” will save the library in the user’s registration name.

5.31 Creating and Opening Multiple Libraries

The Handwriting Recognition program allows for multiple unique libraries to be created and retrieved. If
multiple presenters are using the StarBoard’s Handwriting Recognition feature, each presenter can create
their own library and call it up when they are using the board.
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To Create a New Unique Library:

1. Double tap on the pen/pointer icon in the task bar. This opens up the handwriting
recognition menu.

2. Select “Properties”, then the “Library” tab

Gesssal | bk | Hoi Bep Lbswy | Compionnts |
Toarsy Danch W57 Mindski]

H

3. Select the “Change” button.
0 This opens the “Load Library File” dialogue box.
0 Type in the new presenter’s name in the “File name” box.
0 Press the “Open” key
0 A response warning states that the file does not exist. Press “OK” to create a new
library.

o It responds that a new library has been opened and prompts you to begin a new
quick training session

To open a previously saved library:

1 Double tap on the pen/pointer icon in the task bar. This opens up the
handwriting recognition menu.
2 Select “Properties”, then “Library”

Gasuid| ik || Hotiay  Lbisiy | Cariruinia |

T ey Dl | il

ne | cwes | |

2. Select the “Change” button.
0 This opens the “Load Library File” dialogue box.
0 Select the presenter’s library filename (*.LBR).
0 Press the “Open” key
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MultiMedia Notepad
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6.1 Description and Features

Multimedia Notepad is a powerful and robust project-based program that organizes and controls
presentations in an electronic flipchart format.

% Untitiled - HS Multimedia Notepad
Flo Edt Jook Page Inset AudioVideo Database Utliies View Help

DSHS & 0B@ (0 4= ME D e
— 4] e, e AINN|S#OCLHILO00ROEAN
DDIEIIIIIDDIIIIDIT\

o | o

TotslPages: 1| [ % [N A1 | Pece#1 | ]
= Ravm | |

Features

1. Microsoft Word documents, Excel spreadsheets, PowerPoint presentations and other
applications can be imported into Multimedia Notepad. Each page of the imported document
is assigned a page in the electronic flipchart. A variety of image file formats can also be
imported.

Multimedia Notepad provides tools for drawing and annotating documents.
3. The drawing toolbar can be used to create and diagram charts.

4. Objects and documents in OLE format can also be imported into a project for editing in
Multimedia Notepad.

5. Audio and video files can be embedded into a Notepad presentation and played back at any
time.

6. The handwriting recognition and on-screen keyboard utilities allow direct data entry from the
whiteboard.

6.2 Starting Multimedia Notepad

To open the Multimedia Notepad program, either:
1. Select MultiMedia Notepad from the ShareWizard Launcher toolbar

m r A Pen QMultiMediaNntepad | ;,;)]‘-.-’ideu:u Pen

2. Select MMNotepad from the ShareWizard program group

From the {Start} menu — Select {Programs}
ShareWizard/MMNotepad
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6.3 Title Bar

The Title Bar contains the following: the Window Control menu, the program title (including the name of
the active document), minimize/maximize controls, and the exit button.

UE Untitiled - HS Multimedia Notepad M=l E3

6.4 Menu Bar

The Menu Bar contains the following command drop-down submenus:

File Edit Toolz Page |nsert Audio®fideo Databaze  Utiiies “iew Help

6.5 File Menu Components

The File Menu allows file management, image and document importation, project printing, and exiting.

New Project:

Open Project:

Import File:

Save Project:

Save Project As:

Print Project:

Exit:

Opens a new, blank Multimedia Notepad project file.

Opens an existing Multimedia Notepad project file (.mmn).

An “Open File” dialog appears for file selection. Click on “Open” to open the desired
project file. Notepad can also open the .npd (MultiMedia Notepad), .pen (HS Pen) or
.swm (ShareWizard) file formats.

Imports images or documents into Multimedia Notepad.

Notepad accepts the .doc (Microsoft Word), .xIs (Microsoft Excel), and .ppt
(Microsoft PowerPoint) file formats. When importing a file into the current project,
the program assigns each page of the imported file a separate page within the project,
subject to a 15-page maximum.

Saves the active Multimedia Notepad project.

Notepad saves the document in a proprietary format used only by Hitachi Software
programs. If the project already has a filename specified from a previous save, the
program saves the project under the same name. Otherwise, the “Save As” dialog box
appears. To save, type in a name for the project and click on “OK”. This creates a
directory with the assigned name and saves the pages of your project to that directory.
The files of the project will all have the same filename, but each will have a unique
extension.

Saves the active Multimedia Notepad project.
This function is nearly identical to “Save Project”, except the “Save As” dialog box
will always appear even if the project already has a filename.

Opens the standard Windows Print dialog box.

Options such as selecting which pages, the numbers of copies, or any other options in
the Printer driver program are available in this dialog. After setting the print
properties, click on “OK” to begin printing.

Closes the Multimedia Notepad program

If the changes to a project have not already been saved, a message prompt asks
whether or not the project file should be saved before closing the program.
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6.6 Edit Menu Components

The Edit menu allows the copying of Multimedia Notepad contents to the clipboard and vice versa.
Annotations on any page of the project document can also be cleared through the Edit menu.

Undo: Reverses up to the last three actions.
Cut: Deletes the selected object from the page.
Copy: Copies the selected bitmap image or Multimedia Notepad object(s).

Paste: Pastes the bitmap image or Multimedia Notepad objects that are on the clipboard to
the active page of Multimedia Notepad.

Clear All Strokes: Clears all of the annotations from the active page, but leaves the imported images,
drawing, or other objects intact.

Clear All:  Clears all annotations, links, and background images from the active page, regardless
of when they were created.

Toggle Fill:  Toggles the selected object between outline and solid color modes.

Links: Edits existing OLE links in the current project.
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Objects: Allows the opening or editing of existing OLE objects in the current project.

6.7 Tools Menu Components

The Tools Menu contains the Pen, Highlight Pen and Erase tools. The current active tool displays a check
mark to the left of the tool name.

Select: Activates the select command
To select an object, tap on any object in the Main Display Window.

Pen: Activates the pen tool
The pen tool allows the drawing of lines in the Main Display Window.

Highlight: Activates the highlighter tool
The highlight tool allows the highlighting in the Main Display Window.

Eraser: Activates the eraser tool
The eraser tool erases freehand annotations.



Fill:

Text:

Shapes:

Lines:

Connectors:
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Activates the fill color function

When this function is selected, any shape created in the Main Display with the shape
commands will be filled with the active color in the color palette. This function does not
apply color to already existing shapes in the Main Display. To fill an existing drawing
shape with a solid color, use the Toggle Fill command.

Activates the text function
To add text to the page, tap on the desired location within the Main Display. With
computer keyboard, the on-screen keyboard, or the Handwriting Recognition software
input text to the active page.

Activates the shape creation tool

The Multimedia Notepad program contains a drawing tool bar that contains a variety of
shapes. Selecting any of the shape commands creates the active shape for drawing. The
shapes available are:

Curve Rectangle Circle Parallelogram
Trapezoid Diamond Rounded Rectangle  Octagon
Dialog Box Hexagon Star Triangle

Allows the selection of a line style and activates the line tool.

Lines can connect two different objects. To create a line, tap on the origin object. Place
Pen Tip on the origin object and drag the line to the desired target object. A line
connecting the two objects will be created.

Allows the selection of a line style and activates a connector tool.

Like regular lines, connectors can connect two different objects, but, unlike lines,
connectors are dynamic. When a connected object is moved, the connector will reorient
itself as well so that the connector will always be linking the two objects. To create a
connector, first place the pen on an origin object. Potential linkage points on the
perimeter of the object are highlighted red when selected and green if unselected. When
the desired potential linkage point on the object perimeter is highlighted red, drag the line
to a potential linkage point on the target object. A bent-line style is also available for
bent connectors.

Example of using objects selected from the Tools menu.

4% Untitiled - HS Multimedia Notepad
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6.8 Page Menu Components

The Page Menu contains functions that help in managing pages within the project.

Add:

Insert:
Remove:
Save Current

Page as Image:

Page Sorter:

Font Options:

Adds a new, empty page to the project, document after the last existing page.
Inserts a new, empty page to the project before the active page in the Main Display.
Removes the displayed page of the project document and renumbers the remaining

pages of the project accordingly.

Saves the current page as an image file.
When this option is selected, a “Save As” dialog box appears. Once the filename and
file format are selected, click on [OK] to save the image.

Opens the Sorter dialog box. In the Sorter dialog box, all of the pages in the project
appear as thumbnail images.
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The following options are available:

Slide Bar: Scrolls through the pages of the project
Go To: Switches to the selected page when “Go To” is clicked
Delete: Deletes the selected page from the project
Insert: Inserts a blank page before the selected page

The pages in the project can also be rearranged by clicking and dragging the thumbnail
image to the desired location.

Opens the font dialog box.

In the font dialog box, the font type, style, size, effects and color attributes can be
modified. After making a selection, a sample with the selected font and font
characteristics will appear in the Sample box.
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6.9 Insert Menu Components

The Insert Menu allows for the insertion of objects and images into a Multimedia Notepad project.

Loads and inserts an image file.
Notepad can import the .cmp, .jpg, .pcx, or .bomp file formats to the current page.
An “Open” dialog box will appear for filename selection.

Insert Picture:

The imported image file may be annotated as in this example:

Insert
OLE Object:  Imports an OLE Object
An OLE object is linked to the original file and program that created it. After double

clicking on an imported OLE object, the original program will open, and the image or
document can be further modified.
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6.10 Audio/Video Menu Components

The Audio/Video Menu allows the creation and editing of audio and video recordings. The project must be
saved and given a name before this feature can be used.

Add Audio:

Playing the
Embedded Audio:

Add Video:

9 mmnTmp1.mmn - HS Multimedia Notepad
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Creates or imports from a file a sound recording and embeds it within the active

project page
1. When this command is activated, the cursor changes into a floating hypertext
button with a speaker image on it.
2. Move the cursor to the desired hypertext button location.
3. Double click or double tap at the location. This embeds the hypertext button and
opens the Audio Record/Playback dialog box.
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4. Create or import an audio file. The dialog box also allows for playback and re-
recording.
5. Clicking on [OK] saves the audio sample. The Audio Record/Playback dialog

Plays the audio track when activated. E@

1.
2.
3.

box will close and the audio icon will appear in the display area.

FiTh

Activate the Select tool.

Double click on the audio icon to begin playing.

Allow the audio clip to finish before resuming operations, or click on the Audio
Stop command from the Audio/Video menu.

Embeds a video clip into the active project page.

1.

2.
3.

When this command is activated, the cursor changes into a floating hypertext
button with a video player image on it.

Move the cursor to the desired hyper-text button location.

Double tap at the location to fix the embedded hyper-text button. The *“Open”
dialog box will appear. Select a video file (in .mpg, .avi, or .mov file formats) for
the hypertext button to play.

Click on “Open” to close the “Open” dialog box and place the video icon in the
display area.
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Activate the Select tool.

e

2. Double click on the video icon to start the video viewer. The first frame of the
video will be visible in the viewer window.

3. The standard video controls to start, stop, rewind and fast-forward the video
become available.

4. Use the pen and eraser tools to annotate a video frame. When a drawing tool is
selected, the video freezes at the current frame.

5. Select the video start control when finished to save the annotated still frame to a
file as a bitmap image. The video clip will then continue.

Z| pu|wlelv] o= (@2 o

Play: Plays a selected embedded audio or video clip.

AudioStop:  Stops a currently playing audio clip.
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6.11 Database Menu Components

This option sets up a database with up to five fields. The database establishes objects in a diagram and
assigns input data to each object.

Creating a Database Structure

1. Select “Open” from the Database menu to open the Database dialog box.
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2. Select “Setup Database” to open the Database Tablet Setup dialog box.
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3. The system sets up two mandatory fields—“Object ID” and “Page ID”. To add to the
database structure, enter the field names and information. In the “Attribute Info” text
boxes, set the following parameters:

a) Type the field name in the Name box. A field name can contain up to 64
characters.

b) Select the field type from the “Type” box drop-down list. The options are
Double, Long, and Text types.

c) If the type is a Text field, specify the length. For Double and Long field types,
the program fixes the size automatically.

4. Click on “Add” to accept your field entry. The information should appear in the “All
Defined Attributes” box.

5. To change an entry, delete the entry and add the entry again with the correct information.

6. Click on “Close” to close the Database Tablet Setup dialog box
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Building the Obijects in the display area created with the drawing tools can be attached
Database to a record.

1. To attach a record to an object, double click on an object in the display area
with the select tool. The “Database” dialog box will appear with the selected
object highlighted.

2. Type the database information for this object in the appropriate fields.

3. Click on “Close” to return to the display area. Once the information is set, the
database information related to that object will be shown when the object is
double clicked.

Printing
Database Reports  Click on “Print” in the Database dialog box to bring up the Print Report dialog box,
which designs the print report
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1. The topmost register displays the records in the database.
In the Filters section, highlighted field attributes are displayed in the report.
3. Set the filters for certain criteria:
a) In the “Attribute Name” field, select an attribute from the drop down list.
b) Select a logical operator from the drop down list
¢) Type in the desired value for filtering the attribute.
4. Set another set of criteria by filling information in the second set of fields if
needed.
5. If two sets of criteria are set, then select “And” or “Or” for the operating criteria.
Click on “Close” to exit the dialog box without printing a report.
7. Click on “Print” to print the report with the set criteria. The standard Windows
print dialog box will appear.

N

o

Synchronize:  Synchronizes or harmonizes a database for information and objects imported into
Multimedia Notepad.
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6.12 Utilities Menu Components

Handwriting
Recognition:  The Handwriting Recognition program converts handwriting into printed text (ASCII
format).

To operate the Handwriting Recognition program

1. Select the Handwriting Recognition icon and then select the Text Tool.

2. Place the text cursor in the desired location, and write text by hand anywhere on
the main display. The handwriting will be converted and copied into the text
area.

3. Clicking on the pen-shaped icon in Microsoft Windows system tray toggles the
handwriting recognition function on and off. This system tray icon can also
access Handwriting examples and other related information.

(See Chapter 5 — Handwriting Recognition for more details.)

On-Screen  The On-Screen Keyboard allows you to enter text without the computer keyboard.
Keyboard:  To operate the On-Screen Keyboard:
1. Click on the Keyboard icon.
2. Function keys such as Esc, Alt, and Cap lock are also available on the On-
Screen Keyboard.
3. To close the On-screen Keyboard, click on the “X” button in the upper right-
hand corner.

6.13 View Menu Components

The “View” Menu can hide or display many of the toolbars. A check next to the toolbar name in the
menu means that the toolbar is currently visible. To change the status of any toolbar, click on its name in
the “View” menu to toggle the toolbar on and off. Other options in the View Menu include:

Grid Lines:  Toggles the grid lines on and off. The grid lines can aid in drawing straight lines and
Zoom: aligning objects in the display area. Opens a new window that can zoom the contents

of the display in and out. When you wish to return to the main program, click on

“Close”. Pages can also be changed within the zoom window. The horizontal and
vertical slide bars are used to view parts of the display that are not visible in the zoom

window.
Zoomed in: Zoomed out:
m— m=0|
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Cover: Places an opaque curtain over the contents of the display. Selecting an area on
the opaque curtain with the cursor reveals the area of the display underneath the
curtain.
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The Curtain Hiding the Display Revealed Display Area Underneath the Curtain
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6.14 Help Menu Components

The Help menu contains two entries, About Multimedia Notepad and Help.

About MM Displays an information box containing the version number and copyright
Notepad information
Help: Opens the online Multimedia Notepad Help System. Pressing the F1 key at any time

can also bring up the On-line Help System.

6.15 Main Display & Scroll Bars

The Main Display area is for importing images and documents, as well as annotating and drawing with the
program tools. The vertical and horizontal scrollbars allow movement around the Main Display area if the
display area is larger than the window area.

6.16 Command Icons Bar

The Command Icons Toolbar contains the most frequently used commands of the Menu. The functions of
these icons can be found in the Menu Bar section. The Command Icons are:
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Command Icon Functions:

New Cover Apply Dotted Style
Open Grid Lines Apply Elbow Style
Save Zoom Apply Start Arrow Style
Print Hand Writing Recognition Apply End Arrow Style
Cut On Screen Keyboard

Undo Vertical Flip

Copy Horizontal Flip

Paste Toggle Fill
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6.17 Tool Icons Bar

The “Tool Icons” Bar contains the icons and controls of tools for drawing and annotating in the Main
Display area. The functions of the tools in the “Tool Icons” Bar are identical to the counterparts in the
“Tools” Menu.

—d] M2 AINNROCODAOO0B0ORAN

Tool Size Display: Displays the exact size and color of the tools for drawing.

Tool Size Control:  Controls the tool thickness
1. To decrease the size, click on the left-facing arrow labeled "fine".
2. To increase the size, click on the right-facing arrow labeled "thick".
3. The sliding bar can also be moved to change the tool size.
4. The line in the Tool Control Display also changes to reflect the current tool size.

Color Palette: The Color Palette contains 16 colors. Clicking on the color box in the Color

Palette can change the color of the pen and highlighter tool. The line in the
“Tool Control” Display also changes to reflect the active color.
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The page control bar allows easy access to other pages in the project by simply clicking on the numbered
page tabs beneath the main display area. A project may contain up to 15 pages.

I Total Pages: 1 _DJ" Ll _hll Page #1 I

Total Pages: Displays the total number of pages in the active project

Add: Adds a new page as the last page of the project
Remove: Removes the currently displayed page of the project

Page Scroll:  Allows movement through the range of page tabs displayed in the window
if the page tabs extend beyond the available space on the control bar

Page Tabs: Represents a page in the project and allows jumping between pages. Each page in the
project has a page tab. To move between pages, click on the desired page tab. The
page will become the active page in the Main Display area.

6.19 Status Bar

The status bar contains information concerning the state of the program, the coordinates of the cursor and
other active control icons such as handwriting recognition.
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7.1 What is TeleMTG?

ShareWizard TeleMTG is a teleconferencing program that allows communication with other users over the
Internet or a Local Area Network. Programs and files can be simultaneously shared, and prepared
materials contained in MultiMedia Notepad can be reviewed. Features include taking notes, changing
existing presentations, and saving files electronically. TeleMTG also provides voice communications with
a full duplex single audio channel. TeleMTG can be operated with any input control device (StarBoard,
touchscreen, mouse, or graphics tablet.)

TeleMTG Specifications
0 Maximum of 10 participants per session.
0 Up to 5 programs may be shared at one time.
o Certain types of programs, especially database programs, do not work well in a TeleMTG
session.

HS TeleMTG consists of two windows: the Meeting Information Window and the Meeting Control
Window.

7.2 Meeting Information Window

The Meeting Information Window provides useful information about who is attending and the programs
that are being shared.
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Meeting Status: Indicates whether a session is active or not
Users: Contains the names of the Users participating in the meeting
Shared Programs: Contains the names of any active programs being used in the session

7.3 Program Control Window

Use the Program Control Window to access and change meeting parameters.

7.4 Meeting Control

The MTG Control Dialog Box contains commands located at the bottom of the dialog box. The End
Session button ends the current meeting, and the Exit button closes the program.

NOTE: Use the “END SESSION” button to end every teleconference. This will successfully close the
TeleMTG program and terminate the session with the other users.
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7.5 Meeting Users

The MTG Users dialog box displays an address book that contains the names of all registered users and
their TeleMTG addresses.
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7.5 Meeting Users (Continued)

Adding a New User:
1. To add a new user to the address book, first click on the Add User command. This brings up the
Add User dialog box.
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2. Type the User Name in the text entry box.

3. Type the User IP Address in the appropriate box.

4. Click on [OK] to confirm your entry. This copies the information to the next free line in the
address book.

5. To close the Add User dialog box without saving any new user information, click [Cancel].

Deleting a User
1. To delete a user or users from the address book, first highlight the user name line(s) in the Meeting
Users dialog box.
2. Click on the Delete User button. This removes the user name and address from the program.

Inviting a User to a Meeting Session
1. To invite a user to a meeting, highlight the user name in the address book.
2. Click on the Invite command. This brings up the Audio dialog box.
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3. The Audio dialog box allows the following options:
» Opening the voice channel with the selected meeting participant by clicking on [OK]
» Choosing to have no audio connection by selecting the No Audio command
* Canceling this dialog box and returning to the main address book by clicking on [Cancel]
4. After inviting another user, the program returns to the main MTG Users dialog box. The invited
user now appears in the Meeting Information window. Additional users may be selected one at a
time by the same process.
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7.6 Share Program

The Share Program dialog box displays the selection of programs to share with other meeting participants.

MTEG Conol | MTG Users Shars Prograre | WTG Hotepsd | Send Fles | Heipbou |

Slaat p pangesn sred shawe if rath wessting L
Jrerna wireeoed [

= Ba

During a conference session, a hew program can be opened or an existing running program can be shared
with all participants.

To share a program that is not already running:

1. Type the drive and full pathname of the program file in the text entry box or recall a recently
opened program by clicking on the down arrow to the right of the text entry box. Highlight a
program name from the drop down menu, and hit [Enter] or double-click on the name. The file
name list closes and the selected file name appears in the text entry box.

2. Click on the Browse button. This displays the Windows File Browser. Selecting a file from the
Windows File Browser copies it to the text entry box.

3. Click on the Start button to initiate file sharing with the other meeting participants. The file name
will appear in the Meeting Information Window.

To share a program that is already running:
1. Click on the Share a Running Program button. This brings up a list of programs that are
currently open.
2. Select a running program from the list and press [Enter]. This creates a program link that allows
all other meeting participants to share the running program.

Shared Programs:
Any user may start a shared program. However, only the user who starts the shared program can operate
the commands of that program. All meeting participants can view the active shared programs.

True Collaboration:

True collaboration, unlike simple program sharing, allows any meeting participant to control the program.
To use True Collaboration, first select a program and start the program sharing function. Select the Enable
Collaboration command. Any meeting participant may control the open shared programs.
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7.7 Meeting Notepad

The Meeting Notepad Dialog Box contains the Meeting Notepad. Here users may take notes, import
documents or graphics to create a presentation, make annotations, save their work, and print the output.
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A meeting session must be in progress before Meeting Notepad can be accessed. Otherwise, a message
prompting the user to start a meeting will appear. Please refer to Chapter 6 — MultiMedia Notepad for a
more detailed overview of Meeting Notepad.

7.8 Send Files

The Send File dialog box can send files from your computer to all the current meeting participants. Use the
Browse command to select files and the Transfer command to send the selected files.
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7.9 Help/About TeleMTG

The Help/About dialog box contains information about the HS TeleMTG program, including the version
number. It also allows access to the On-line Help System. To access the HS TeleMTG On-line Help
System, click on the Help command. The On-line Help System can be accessed at any time also by
pressing the F1 key.
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7.10 Quick Start TeleMTG Session

1. Research all participant’s IP addresses (max 10 users)

Each Participant must be on-line.

To find out what each IP address is, each participant should perform the following task:
a. START>RUN
b. Enter “winipcfg” in dialogue box

It will return with an IP address for that PC. Ex: 38.29.66.244

2. Have each user start TeleMTG.

This brings up the 2 window screens.

3. The Host/Presenter enters names & IP addresses of participants.

Host selects the MTG Users tab
c. Type in name of participant
d. IP address (with periods)
Repeat till all participants are entered)

4. The Host/Presenter invites each particpant.

MTG Users > Invite button

Audio Selection box appears. Only one channel is available.
Click the No Audio Button for this demo

HS TeleMTG Message appears:

“Inviting users, this may take a moment.”

Click OK immediately when prompt.

5. TeleMTG acknowledges connection with invitee.

The top TeleMTG box labeled MTG Information will display:
Meeting is Active
Users: Names, connection ID

This information should appear on each connected user’s screen.

6. Meeting can begin.

Presenter can now display his application programs.

7. Sharing Programs
Click on Share Program tab
Choose either
1. Starting an application program from this screen
BROWSE > select program.exe > START
2. Sharing a program that’s already running on the presenter’s PC.
Selection box appears with all open programs. Select Share
3. Use MTG Notepad
Click on MTG Notepad tab. This opens up the MultiMedia Notepad

0 The host must remember to minimize the TeleMTG application when selections are
completed. The TeleMTG screen is blocked out on the remote screens so participants
can not see the setup information.

0  When shared program can be seen remotely, participants can maximize presentation to
full screen.
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7. Interactive Collaboration
Participants in the conference can collaborate or interact with the host’s presentation.

1. Follow the steps above for sharing programs.

2. Click on Enable Collaboration. The button will change to Disable Collaboration.
The top MTG Information box will show Collaborating as Enabled only on the
host’s PC.

3. To take control from the host’s PC, participants must double click their mouse. Their
cursor will turn active. For best performance, wait till active writing by the remote
user has stopped briefly before double clicking to take control.

8. Ending Session
Select MTG Control tab
Click End Session button
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8.1 Introduction
ShareWizard VideoPen allows users to control Windows video files.
1. Play, Rewind, Stop and Freeze frame.
2. Draw over video freeze frames with VideoPen
3. Save and Print annotated frames.

8.2 Playing a Video File

1. When the Video Pen opens, the Video Viewer Main Toolbar first appears.
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2. Toopen a video clip file, select the File Icon from the Main Toolbar. The file Browser opens.
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3. The File Browser allows:
e Selecting a video clip file from the default VideoPen directory
»  Moving to any other directory that contains video clips

4. After choosing a file, the VideoPen viewing frame opens with the video clip loaded. All of the
icons on the Main Toolbar also become active.

5. The Main Toolbar Icons provides the following controls:
»  Start, Pause, Rewind, Forward, and Backward for navigating through the clip
«  Zoom control for changing the size of the video viewer window
e Opening another video file
» Accessing help
»  Exiting the VideoPen program
»  Selecting the Pen for frame annotation
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8.3 Annotating a Still Frame

1. Start playing the video clip by clicking on the Forward icon on the Main Toolbar.

2. Select the Pen icon from the Main Toolbar. This opens the Pen Toolbar and freezes the video clip
at the current frame.

HS VideoPen ___||

3. The selected frame becomes available for annotation. From the Pen Toolbar, use the color palette
to change colors or the slide control to change the width of the drawing line.

4. A Highlighter tool (transparent ink) can highlight frame segments, and an Eraser tool can erase
annotations from the screen.

5. To save your annotated still video frame:

» Select the Snapshot icon (the camera) to save in standard bitmap format. This format may be
used with any software application that reads the .bmp format.

» Select the Save icon (disk) to save in a two-layer format. This format separates the
annotations from the underlying image. Other Hitachi Software utilities can then be used to
edit the annotations. The two-layer format is a special proprietary format (.pen) and may only
be viewed and changed through Hitachi Software programs.

Note: After the file is saved, the movie file will continue to play. All saved files are placed
in the time-stamped folder inside the date-stamped folder. Both of the saving
functions automatically save the image in a directory that contains the current date, in
the form of MMDD, as the name. The saved image also records the time in its name
in the form of HHMMSS.

6.  The File icon browses through file directories for opening video clips.
7. The Clear Ink icon (the “x™) removes all annotations from the still video frame.

8.  The annotated image can be saved to the clipboard and imported to other applications by clicking
on the Clipboard icon.

9.  To close the annotation window and Pen toolbar and return to the Main Toolbar and viewing
window, click on the exit control in the upper right corner of the annotation window.
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8.4 Viewing and Working with a Saved Frame

1. When the Pen Toolbar is open, the selected annotation frame can be opened for editing by clicking
on the Works in Progress icon.
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2. This dialog allows the following functions:
« Scrolling through the captured still frames by using the “Previous” and “Next” button.
*  Opening a selected frame to full size by clicking on the thumbnail of that frame and then
clicking on the “Open Selected File” button.
*  Closing the “Works in Progress” thumbnail viewer with the “Close” button.
3. After opening a thumbnail to full size, the Pen Toolbar appears. Annotations can be edited with
the Pen Toolbar utilities.

4. To view the annotated image in a larger format, click on the “Maximize” button in the annotation
window.

5. Click on either of the “Save” icons to save the changes.

8.5 Selecting a Location to Save Annotated Frames

1. When an image is saved with the AutoSave functions, it time-stamps the image and stores it in the
default directory with the current date.

2. To change the directory where AutoSave stores the image, click on the “Saving Preference” icon.
This opens the “Choose File” dialog box

3. Find the desired directory folder for storing AutoSaved images. Click on the Select button to
confirm the location. The File Browser will close and the VideoPen screen will reappear.
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9.1 What is DryErase Screen?

DryErase Screen is the software program that allows for notations in dry erase ink on the StarBoard to be
saved and printed as computer image files. Excellent as a meeting or training tool, the presenter can draw
or write on the whiteboard with standard dry erase markers that are inserted into the StarBoard pen holders,
and then save or print the entire board’s markings as an image file, thus an electronic copy.

(See Section 1.4 on Dry Erase Mode in Chapter 1 — Hardware Installation.)

9.2 Drawing in DryErase Mode

To draw in dry erase mode:

1. Do NOT use a projector in this mode.

2. To Start the Dry Erase Screen Program, use a mouse to:
0 Select the DryErase Screen in the Launcher Bar or
0 Select the DryErase Screen program from the ShareWizard Program group
The computer screen should display a white page with the Dry Erase Screen toolbar at the
bottom.

3 Remove the cap from the StarBoard pen tip and begin writing in dry erase ink on the board.

4. The connected computer screen will simultaneously show the markings in real time as electronic
ink on a white page.

To erase both dry erase ink and electronic ink:
1. Use the opposite end of the marker pen (small felt pad) to erase markings.
2. Use the large format eraser (hockey puck size) to erase bigger areas.

9.3 DryErase Screen Toolbar

The DryErase software toolbar contains all of the feature commands listed below in this chapter. Because a
projector is not used in the DryErase Screen mode, this floating toolbar can be viewed only on a computer
monitor or laptop screen. A computer mouse is required for selecting any of the command icons on this
toolbar.

9.4 Saving the Screen Image

The dry erase markings can be saved as an electronic image in bitmap (BMP) format. To save the screen,
simply click on the Save icon or the Save and Clear screen icon on the StarBoard’s front Control Panel.
There is also the option to Save by selecting either icon on the Dry Erase screen toolbar.

= - B

The exact directory and filename are set in the program options dialog box. Please refer to the Program
Options section for more information. The current set of pages can be saved in the WNR format and
reopened in a later session prior to quitting the program. WNR format allows special support for multiple
pages and annotation playback.
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9.5 Clearing the Screen

To clear the screen of all markings, push the Clear Screen button on the StarBoard’s Control Panel or click
on the toolbar’s Clear Screen icon.

P

Note that the annotations are not deleted. Instead, a new page is added every time Clear Screen is clicked.
To access different pages in DryErase Screen, please refer to Section 9.8 on Page Navigation.

9.6 Printing the Screen

To print the markings on the StarBoard directly to a printer, press the Control Panel’s Print button or click
on the toolbar’s Print icon. The standard printer options should then appear.

|i

9.7 About DryErase Screen

To display the information dialog box, select he “About” icon on the toolbar.

|'=EI

9.8 Opening a DryErase Screen File

To open a DryErase Screen file, click on the Open icon from the toolbar.

|
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Note that only the WNR format can be read by DryErase Screen. Files in bitmap (.BMP) format cannot
be opened in DryErase Screen.

9.9 Closing DryErase Screen

To close the DryErase Screen program, click on the Close icon. A prompt will appear asking whether or
not the current set of pages should be saved. If the answer is yes, then the page data is stored in a WNR
format file, readable only by DryErase Screen. This file can be opened in later sessions of DryErase
Screen.

]

Multiple pages can be accessed through the page management tools.
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9.10 Page Navigation

Whenever the Clear Screen command is used, a new blank page is created. If multiple pages exist during
the current session, the Forward and Backward icons in the main toolbar allow navigation through the
pages. When at the first or last page, the forward or backward icons will become inactive.

& T G

To see thumbnail images of the entire session, select the page browser icon.
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This will open the page Browser:
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Within the Page Browser window is a preview of each page created during the session. If there are more
pages than can be displayed in the window, use the scroll bar to scroll through the pages.

The following buttons are displayed:

Select: Sets the selected page in the window as the current page
Delete: Deletes the selected page in the browser
Close: Closes the browser without making any changes
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9.12 Using Annotation Playback

Dry-Erase Screen includes an Annotation Playback feature that sequentially redraws all the markings on
the dry erase page. Thus, an entire Whiteboard annotation session can be replayed on the computer.

To begin playback, select the Playback icon on the floating toolbar.

i

The display animation will recreate the entire page of annotations in the order they were originally
created. Also, the main toolbar will become the playback toolbar.

The playback toolbar offers the following options:

4 » =
Rewind: Restarts the animation
Play/Pause: Pauses the animation if it is in progress; otherwise, it will continue playing the
animation
Stop: Closes the playback toolbar and returns to the main toolbar

Annotation Playback data is only saved in the WNR format file. The BMP format file does NOT contain
annotation playback information.

9.13 Changing the Save Directory

Program options allow for the management of image files when screens are saved and exported. To change
the Save directory, click on the Options icon in the main toolbar.

In the Save Directory area, either type in the directory path or click on the Browse button to select a path.
All files will then be saved in a specially named folder within this directory.
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9.14 Naming the Save Folder

To change the name of the Save folder, click on the Options icon in the main toolbar.
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In the Save File area, specify whether saving files should be organized by session or by day.

When the files are saved by session, BMP and WNR files will be stored in a folder named with the date and
time, in YYYYMMDD_TIME format, in the Save directory. Each BMP file in the folder will be named
consecutively by the order of saving (0001.BMP, 0002.BMP, etc.).

When the files are saved by day, BMP and WNR files will be stored in a folder named with the date, in
YYYYMMDD format, in the Save directory. Each BMP file in the folder will be named with the time.
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